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Preface

The Sun Management Center 3.5 Update 2 Performance Reporting Manager User’s Guide
provides instructions on how to use Performance Reporting Manager to create system
management reports.

Who Should Use This Book
This document is intended for users familiar with the Sun™ Management Center
product. Therefore, many terms and concepts specific to the Sun Management Center
are not explained here. For more information about Sun Management Center, refer to
the Sun Management Center 3.6 User’s Guide.

How This Book Is Organized
This document describes all services offered by Performance Reporting Manager. It
includes the following chapters:

� Chapter 1 provides an introduction to Performance Reporting Manager.
� Chapter 2 includes installation and setup instructions.
� Chapter 3 includes instructions for using standard reports.
� Chapter 4 includes instructions for using custom reports.
� Chapter 5 includes instructions for using report options.
� Appendix A provides reference information for Performance Reporting Manager.
� Appendix B includes instructions for installation and setup using the command

line.
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To view license terms, attribution, and copyright statements for open source software
included in this release, the default path is
/cdrom0/image/Webserver/Solaris_x/SUNWtcaxx/install/copyright.

Access to Latest Information About Sun
Management Center
The latest information about Sun Management Center software and add-on products
is available at theSun Management Center web site
(http://www.sun.com/solaris/sunmanagementcenter).

You can take the training class “Systems Management Using Sun Management Center
3.5” through Sun Education. For more information, see the US catalog
(http://suned.sun.com/US/catalog/courses) or the worldwide centers web
site (http://suned.sun.com).

Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.

Ordering Sun Documentation
Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.
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Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value

The command to remove a file
is rm filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized

Read Chapter 6 in the User’s
Guide.

Perform a patch analysis.

Do not save the file.

[Note that some emphasized
items appear bold online.]

Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the
C shell, Bourne shell, and Korn shell.

TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $
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TABLE P–2 Shell Prompts (Continued)
Shell Prompt

Bourne shell and Korn shell superuser prompt #

10 Sun Management Center 3.6 Performance Reporting Manager User’s Guide • February 2005



CHAPTER 1

Introduction to Performance Reporting
Manager

This chapter discusses the following topics:

� “About Performance Reporting Manager” on page 11
� “Data Collection Process” on page 12
� “Report Manager” on page 15
� “Report Requests” on page 15
� “Categories and Subcategories” on page 15
� “Output Format Options for Reports” on page 16

About Performance Reporting Manager
Performance Reporting Manager is an add-on product to Sun Management Center
that enables you to create reports detailing the status of your machines. Performance
data is gathered by the history logging capability that is part of Sun Management
Center. Performance reports generated with Performance Reporting Manager use the
data collected in this manner.

The product includes 16 standard reports for which the report options are predefined.
History logging of the data properties used in standard reports is automatically
started by the software. You can also create your own custom reports by selecting
options from the report templates that are provided. Performance Reporting Manager
can generate the following types of reports:

� Performance
� Hardware system
� Hardware configuration
� Software packages and patches
� Alarms
� System uptime
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To use Performance Reporting Manager, the first step is to install and set up the
add-on software. For information about the installation and setup of Performance
Reporting Manager, see Chapter 2. For additional information about installing Sun
Management Center software, see the Sun Management Center 3.6 Installation and
Configuration Guide.

You can generate any of the standard reports included with the software after the
Performance Reporting Manager software is installed and set up. For more
information about standard reports, see Chapter 3.

You can also create your own custom reports. You select the format for your report
from the available report formats given. Performance Reporting Manager includes
several format options for viewing reports. For information about creating custom
report requests, see Chapter 4.

Reports can provide information about one host, all hosts, or a set of hosts that you
designate. In general, data is collected on the agent machines. The data is then
transferred to a database on the server machine. You can request a report for any agent
machine for which data has been collected. A host must be in the Sun Management
Center server context to be included in a report. For more information about how the
data in reports is collected, see “Data Collection Process” on page 12.

The host name in a report usually refers to the agent machine. One exception is in the
case of alarm reports. Alarms resulting from an agent machine that is down or is
otherwise not responding will list the name of the server machine.

Any standard or custom report can be scheduled to generate automatically at a regular
interval. Additionally, you can save reports in other file formats either for viewing in a
web browser, or for using tools to analyze data. For more information regarding these
report options, see Chapter 5.

Performance Reporting Manager automatically logs a number of data properties.
These properties are predefined for you. For more information regarding this feature,
and for other reference information, see Appendix A.

For information about the installation and setup of Performance Reporting Manager
using the command line, see Appendix B. For additional information about installing
Sun Management Center software using the command line, see the Sun Management
Center 3.6 Installation and Configuration Guide.

Data Collection Process
Before installing and using the software to generate reports, you should have an
understanding of how data collection occurs. The Performance Reporting Manager
add-on product uses the history logging capability for agent machines that is provided
by the Sun Management Center software. A data collection service is created on the
server layer. The following types of data are collected:
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� Hardware system data
� Hardware configuration data
� Software package data
� Software patch data
� Performance data
� System uptime data

The data is logged on the agent machines. The data collection service on the server
layer collects this data from the agent machines and then stores it. The data returned
in reports comes from the data stored on the server or stored on the agent machine.

Raw Data
Raw data is the term given to data that is logged in the history log files located on the
agent machines. The ability to log raw data is a feature of the Sun Management Center
base product. This data can be logged either on a single machine or on a group of
machines by using the grouping capability. If you use the grouping capability, the data
is logged at the time interval that you specify. For more information about the
grouping capability, see “Data Properties” on page 51, and Chapter 13, “Managing
Group-related Jobs,” in Sun Management Center 3.6 User’s Guide.

Raw data is retained on the agent machine for eight days. This limit is necessary
because the total volume of raw data is very large. Data is purged after eight days. For
example, on the ninth day, the first day of raw data is purged from the agent machine.
At any given time on the agent machine, the last eight days of raw data is available.
Before this data is purged, summary records are preserved.

Roll-up Process
Before raw data is purged, the data is summarized or “rolled-up” at predefined
intervals. Roll-up data is the term given to the data that has been summarized. Before
any raw data is purged, the minimum, maximum, and average values are calculated.
These values can be preserved in several ways.

Hourly data is data that is summarized or rolled-up every hour. The raw data for each
hour is processed to create a summary record for that hour. For example, if raw data is
logged every five minutes, a total of twelve raw records are available in one hour.
When data is rolled-up after one hour, the twelve raw records are processed to find the
minimum, maximum, and average values during that hour. One summary record is
generated for the twelve raw records. The hourly data is first computed on the agent
machine. The data is then brought over to the server machine, where the data is added
to the database.

The daily, weekly, and monthly values are calculated in a similar manner. The
maximum, minimum, and average values are also calculated for each period, and the
data is added to the database.

Chapter 1 • Introduction to Performance Reporting Manager 13



Data is retained in the following manner:

� Hourly data is kept for 7 days.
� Daily data is kept for 5 weeks.
� Weekly data is kept for 12 months.
� Monthly data is kept for 24 months.

Depending upon the time range specified in a report request, the most granular data is
returned in a report. For example, if the specified date range is seven days, then
hourly data is returned. If the specified date range is beyond the last seven days but
within the last five weeks, then daily data is returned.

Data for Reports
Data polling starts after the Performance Reporting Manager software is installed and
set up, and once the server is started. The Sun Management Center server starts
polling the agent machines every hour to collect the data logged on those machines.
Logged data is available for reports at the following intervals:

� Hardware system data – 90 minutes after the server is started.

� Patch and package data – 30 minutes after the server is started.

� Hardware configuration data – 90 minutes after the server is started.

� Performance data – 90 minutes after the server is started.

� Uptime Status Reports, Percentage Uptime (Total) Reports, and Total Uptime
(Total) Reports – 90 minutes after the agent is added to the topology of the Sun
Management Center server.

� Percentage Uptime (Detailed) and Total Uptime (Detailed) reports – 1 day after the
server is started.

Data on the agent machines is collected at different times. Data is logged on an agent
machine after the following time intervals:

� Hardware system and hardware configuration data – Every 12 hours.

� Patch and package data – Every 12 hours.

� Performance data – According to the logging interval specified in the Property
Logging Setting dialog box. This data is stored in the history log files.

� Process data – Every 15 minutes.

The data collection service on the server layer collects the data in the following
manner:

� Data is collected from agent machines that are in the current server context and
have the Performance Reporting Manager software installed. The agent machine
must be in the server’s topology.

� Roll-up data for performance is collected every hour.
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Report Manager
The Report Manager GUI is linked to the Sun Management Center Java™ console
only, and is opened from the Tools menu. You manage all report activity through the
Report Manager GUI. For example, from Report Manager you can generate a report,
create a new custom report, or schedule a report to generate at regular intervals.

For more information, see “Report Manager GUI” on page 37.

Report Requests
You can either use any of the standard reports included with Performance Reporting
Manager, or create your own custom system management reports. For all standard
reports, the report specifications and report format are already predefined and saved
for your repeated use.

A custom report enables you to specify the content you want included in your reports,
as well as the report output format. The saved report specifications are called a report
request. The report request is based on one of several report templates. A report request
is used to generate either a standard or a custom report. The report request is also
used to schedule reports to run regularly.

For more information about using standard report requests, see Chapter 3. For more
information about creating custom report requests, see Chapter 4.

Categories and Subcategories
The reports in the Report Manager GUI are organized by category and subcategory
name. The left pane of Report Manager displays a hierarchy view that shows all the
reports by name, both for standard and custom reports.

The first level of the hierarchy contains the category names. The second level of the
hierarchy contains the subcategory names. The report requests themselves are found
at the third level of the hierarchy. All standard reports are organized in the hierarchy
view under predefined categories and subcategories.

You can place any type of custom report under the category or subcategory of your
choosing. This ability enables you to control the organization of your reports.

Chapter 1 • Introduction to Performance Reporting Manager 15



Performance Reporting Manager has the following predefined categories and
subcategories:

� Alarm

� Alarms

� Hardware

� System
� Configuration

� Performance

� CPU
� Swap
� Memory

� Software

� Packages
� Patches

� System Uptime

� Uptime Status
� Percentage Uptime
� Total Uptime

Output Format Options for Reports
Performance Reporting Manager provides the following possible output formats for
its reports:

� Tabular
� Line graph
� Bar chart
� Stacked Bar Chart
� Pie chart
� Area Chart
� Stacked Area Chart
� Comma- or Tab-Separated Text

All format options are not available for every report. The type of report determines the
format options available. Certain formats do not make sense for particular reports, so
these formats are not always given as an option. When creating a custom report
request, you choose from the available format options given at that time.
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Once a report request is saved, an icon depicting the report format option appears in
the hierarchy view in the Report Manager GUI. Each icon is representative of the
format chosen for the report. A lock symbol is added to the icon when the request is
for a standard report that comes with Performance Reporting Manager. Standard
reports have predefined reporting options that you cannot change.

Tabular Report
The tabular report option returns data in table format. The distinctive icon for the
tabular option is a table. The table icon is a grid with rows and columns. The cells of
the table contain the numerical values for the data properties specified in the report
request. You change the column sizing by dragging either edge of the column heading.
If the title to a column heading appears truncated or is followed by several dots, you
might want to resize the column in order to view all information. Tabular reports can
be sorted by clicking on a column, except for performance reports. Performance
reports are presorted according to the time field.

When the Real Time range is selected, you can update the information by clicking the
Refresh button located at the right top of the table. The new data is added to the top of
the table.

Line Graph Report
The line graph report option returns data as graphs with line plots. The line graph
icon is a graph with a climbing, jagged line. The number of graphs contained in each
report depends on the Graph Orientation option selected in the report request.

When the Real Time range is selected for a report, the graph refreshes according to the
refresh interval of the properties being logged. For Real Time reports, only the last
hour of data is visible on the graph at any point in time.

Each line graph report has several viewing options. For example, you can use the
Zoom button to view finer, more granular data for any point on a line. The Alarms
button enables you to obtain the alarm detail for any host included in the report. The
Processes button similarly enables you to obtain the top ten CPU processes and the
top ten memory processes for any host in the report. For more information, see “Line
Graph Report Viewing Options” on page 70.

The following figure shows a sample of a line graph report.
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FIGURE 1–1 Sample Line Graph from a Standard Performance Report

Bar Chart Report
The bar chart report option returns data as one or more graphs with bar lines. The bar
chart icon is a graph that contains three vertical bars. The number of graphs contained
in each bar chart report is controlled by the Graph Orientation option selected in the
report request. This format enables you to create a report that provides a visual
comparison of data values.

Each bar chart graph has the same viewing options as the line graph report option. See
“Line Graph Report” on page 17.
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Stacked Bar Area Chart Report
This report is similar to the stacked area chart report, except the data is displayed in a
series of stacked bars instead of graphs. The distinctive icon for this report is two bar
graphs. For more detail, see “Stacked Area Chart Report” on page 19.

Pie Chart Report
The number of pie chart reports returned depends upon whether the data property
hostname is included in the report request. The report returns data as one pie chart
per host if hostname is specified in the report request. If the data property hostname
is not specified in the report request, only one pie chart is generated in the report. The
following types of reports have the pie chart option: summary reports for system,
package, patch or alarm; percent uptime (detailed and total); total uptime (detailed
and total). The pie chart icon is a circle with a single line that depicts the radius.

For more information about the selection of data properties in a report request, see
“Data Properties” on page 45.

Area Chart Report
The area chart report option returns data for each report property as a separate shaded
area in a graph. The distinctive icon for this report is a shaded graph. The number of
shaded graphs returned in the report depends upon the Graph Orientation option
selected in the report request. If multiple properties are displayed in a report, each
area will be distinguished by a different color. The legend at the bottom of the report
identifies each color to the corresponding property.

When multiple properties are requested in the report, data can be hidden in this view
if one shaded graph overlays another graph. This type of report is good for
determining trends, but might not provide the detail required for analysis because
certain properties might be obscured in the overlay. If you require all requested
properties to show individually, requesting a stacked area chart report or a stacked bar
area chart might be a solution.

Stacked Area Chart Report
The stacked area chart report returns data for each property as a separate shaded area
in a graph, similar to the area chart report. But unlike the area chart report, data is not
hidden when shaded area charts overlay each other. Instead, each property requested
in the report has its own color-shaded graph. These graphs are stacked against each
other. The legend at the bottom of the report associates each color with the
corresponding property. The distinctive icon for this report is two shaded reports
overlaid, or stacked upon each other.
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This type of report is good for analysis of system status because all the requested
properties are displayed. If the requested number of properties is high, however, this
type of report can yield a busy-looking report. If you require only a visual
representation of overall trends, you might want to request an area chart report
instead.

Comma- or Tab-Separated Text Report
This report returns data in a comma- or tab-separated text file, according to the
selection made. The distinctive icon for this report is a text file. A file with data in text
format can be used with other tools to analyze the data, for example, a spreadsheet
program.

If you used previous versions of Performance Reporting Manager, this type of report
could only be generated after a graphical report was requested. This step is no longer
required and you can request a comma- or tab-separated text report directly.

This type of report can also be scheduled and viewed as a web browser report. For
more information, see “Scheduling Reports” on page 66 and “Options for Viewing
Report Output” on page 67.
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CHAPTER 2

Performance Reporting Manager
Installation and Setup

This chapter contains procedures for installing and setting up the Performance
Reporting Manager software using the installation and setup wizards. For information
about using the command line for installation, see Appendix B.

This chapter discusses the following topics:

� “Performance Reporting Manager Software” on page 21
� “Installing Performance Reporting Manager” on page 23
� “Setting Up Performance Reporting Manager” on page 26
� “Before Generating Reports” on page 29
� “Backup and Restore” on page 29
� “Agent Update Feature” on page 30
� “Upgrading Performance Reporting Manager” on page 30
� “Uninstalling Performance Reporting Manager” on page 31

Performance Reporting Manager
Software
Performance Reporting Manager is installed as an add-on to the Sun Management
Center software.

The Performance Reporting Manager server layer runs on the Solaris 8, Solaris 9, and
Solaris 10 operating systems on SPARC® systems only. The server layer requires that
you have 1 Gbyte RAM and 1 Gbyte swap space available on the machine.

The Performance Reporting Manager agent layer runs on the following platforms:

� Solaris™ (SPARC): Solaris 2.6, Solaris 7, Solaris 8, Solaris 9, and Solaris 10 versions
of the Solaris Operating System

� Solaris (x86): Solaris 9 and Solaris 10 versions of the Solaris Operating System
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The Performance Reporting Manager console layer runs on the following platforms:

� Solaris (SPARC): Solaris 2.6, Solaris 7, Solaris 8, Solaris 9, and Solaris 10 versions of
the Solaris Operating System

� Solaris (x86): Solaris 9 and Solaris 10 versions of the Solaris Operating System

� Microsoft Windows 98, Windows NT, Windows 2000, and Windows XP

The following disk space requirements are needed before performing the setup
procedure on the Performance Reporting Manager software.

� Server – The disk space requirement for the server layer can vary based on the size
of the configuration you choose during setup.

� Small configuration – The disk space requirement is 5 Gbytes. This
configuration supports up to 100 agent machines that are monitoring 500
properties.

� Medium configuration – The disk space requirement is 12 Gbytes. This
configuration supports up to 400 agent machines that are monitoring 600
properties.

� Large configuration – The disk space requirement is 24 Gbytes. This
configuration supports up to 750 agents that are monitoring 650 properties.

� Agent – The disk space requirement for the agent layer can vary based on the
number of properties being logged and their log interval. For 1000 properties
logged at five-minute intervals, the disk space requirement is approximately 80
Mbytes.

� Console – 3 Mbytes is the disk space requirement.

Before installing Performance Reporting Manager, you must have the following
software already installed:

� Sun Management Center software
� Config-Reader add-on software specific to your platform

For any late-breaking information, please see the Sun Management Center 3.6 Release
Notes.

The Performance Reporting Manager add-on software consists of the following
packages:

� SUNWescrg – Performance Reporting Manager package for Sun Management
Center console layer

� SUNWessrg – Performance Reporting Manager package for Sun Management
Center server layer

� SUNWesarg – Performance Reporting Manager package for Sun Management
Center agent layer

� SUNWesdrg – Performance Reporting Manager package for Sun Management
Center server layer
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� SUNWeslrg – Performance Reporting Manager package for Sun Management
Center server and console layer

� SUNWeshrg – Performance Reporting Manager online help package for Sun
Management Center server layer (English)

� SUNWesprm – Performance Reporting Manager package for Sun Management
Center server and console layer

� SUNWfrprm – Performance Reporting Manager package for Sun Management
Center server and console layer for French Localization

� SUNWjaprm – Performance Reporting Manager package for Sun Management
Center server and console layer for Japanese Localization

� SUNWkoprm – Performance Reporting Manager package for Sun Management
Center server and console layer for Korean Localization

� SUNWcprm – Performance Reporting Manager package for Sun Management
Center server and console layer for Simplified Chinese Localization

� SUNWhprm – Performance Reporting Manager package for Sun Management
Center server and console layer for Traditional Chinese Localization

� SUNWfrhrg – Performance Reporting Manager online help package for Sun
Management Center server layer for French Localization

� SUNWjahrg – Performance Reporting Manager online help package for Sun
Management Center server layer for Japanese Localization

� SUNWkohrg – Performance Reporting Manager online help package for Sun
Management Center server layer for Korean Localization

� SUNWchrg – Performance Reporting Manager online help package for Sun
Management Center server layer for Simplified Chinese Localization

� SUNWhhrg – Performance Reporting Manager online help package for Sun
Management Center server layer for Traditional Chinese Localization

Installing Performance Reporting
Manager
You can install the Performance Reporting Manager add-on software either using the
installation wizard or the command line. This section discusses how to install the
software using the installation wizard. For information about installing using the
command line, see Appendix B.

The Performance Reporting Manager software can be installed at the same time that
you install the Sun Management Center software. Installation can also be done after
Sun Management Center is already installed.
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Performance Reporting Manager must be installed on the following layers of Sun
Management Center:

� Console layer
� Server layer
� Agent layer, on all hosts for which you want to generate reports

� To Install Performance Reporting Manager During
Sun Management Center Installation

� For more information and detailed steps, see “Installing Sun Management
Center” in Sun Management Center 3.6 Installation and Configuration Guide .

� To Install Performance Reporting Manager
Individually

Note – Perform this procedure only after the Sun Management Center 3.5 Update 2
software has been installed.

1. As superuser (su -), start the Sun Management Center installation wizard by
typing:

# /opt/SUNWsymon/sbin/es-guiinst

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

The Sun Management Center installation wizard appears.

2. Provide the source directory of the Performance Reporting Manager files when
prompted.

� If installing from the software CD-ROM, type:

/cdrom/cdrom0/image

� If installing from a directory to which the software has been copied, type:

disk1/image

where disk1 is the corresponding name of the location where the software was
copied.

Step

Steps
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3. If installing the server layer, select the languages from the Select Language
Support panel and click Next.

The Checking for Available Products panel appears. When the progress bar is
finished, the Products Already Installed panel appears.

4. Review the list of products already installed and click Next.

The Select Add-on Products panel appears.

5. Select Performance Reporting Manager from the list of add-on software to be
installed, and click Next.

The Add-on Products License Agreement panel appears.

6. Read the license agreement. You must click the I Agree button to proceed with
installation.

The Confirmation Panel appears.

7. Review the Confirmation Panel and click Next.

The Installation Complete panel is displayed when the software installation is
complete.

Once installation of the Performance Reporting Manager software is complete, the
setup wizard will guide you through the setup process for the software. For more
information, see “Setting Up Performance Reporting Manager” on page 26.

� To Install Performance Reporting Manager During
Sun Management Center Installation on the
Microsoft Windows Platform

1. Copy the winImage.tar file from the source image.

The usual location is disk1/Window/winImage.tar.

2. Use winzip to extract the tar file, and then save the file to a directory.

3. Change to the directory in which the files were placed, if needed.

4. Start the installation wizard by typing:

disk1\install\install.bat

The Sun Management Center installation wizard for the Microsoft Windows
platform appears.

5. Provide the name of the installed directory, for example, C:>\Program
Files\SunMC.

See Also

Steps
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6. From the list of products available for installation, select Performance Reporting
Manager.

The software is installed.

� To Install Performance Reporting Manager
Individually on the Microsoft Windows Platform

1. From the directory from which Sun Management Center is installed, type:

C:>\Program Files\SUNWsymon\SunMC\SunMC3.5\SunMCInst.bat

2. To start the installation wizard, provide the location of the extracted files by
typing:

C:\install-directory\disk1\image

3. Select Performance Reporting Manager from the list of add-on software to be
installed, and click Next.

The software is installed.

Setting Up Performance Reporting
Manager
After installation is complete, you must run the Performance Reporting Manager
setup wizard to configure the server and agent layers. The setup procedure is not
required for the console layer. You can perform the setup procedure directly after the
software installation is complete, or you can exit the installation wizard and perform
the setup procedure later. If you did exit after installation, the Sun Management
Center core server layer must be set up before you start the Performance Reporting
Manager setup procedure.

The Sun Management Center installation wizard can start the Performance Reporting
Manager setup wizard. The setup wizard appears after the Installation Complete
panel when using the installation wizard. The Performance Reporting Manager setup
wizard guides you through the setup procedure. For the command-line instructions
for running the setup script, see Appendix B.

Steps
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Note – If you later run the re-setup option (es-setup -F) for the base Sun
Management Center software in addition to the Performance Reporting Manager
software, you can lose the scheduled report information. This problem can occur when
you choose not to preserve the base product’s data but choose to save the Performance
Reporting Manager data. In this case, you will need to reschedule the report requests
manually. The original report requests are preserved.

� To Set Up Performance Reporting Manager During
Sun Management Center Installation

� For more information and detailed steps, see Sun Management Center 3.6
Installation and Configuration Guide.

� To Set Up Performance Reporting Manager
Individually

Note – Perform this procedure only after the Sun Management Center software has
already been installed and setup. This procedure assumes that you chose not to set up
Performance Reporting Manager at the end of the installation process.

1. As superuser (su -), start the Sun Management Center setup wizard by typing:

# /opt/SUNWsymon/sbin/es-guisetup

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

The Sun Management Center setup wizard appears and guides you through the
setup process for the software.

Note – If you have installed more than one add-on product, the setup wizard for
each product appears automatically. Each wizard guides you through the setup
process for its add-on product. Each new setup wizard appears automatically after
the setup process is completed for the previous add-on product. The setup wizard
for the Performance Reporting Manager software might not be the first to appear,
in this case.

2. The Overview panel appears first. Click Next to continue through the wizard
panels.

Step

Steps
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3. Review the list in the Stopping Components panel and click Next.

The Sun Management Center components must be stopped before the setup
process can continue.

4. The Advanced Setup Options panel appears if you have completed the setup
process for some of the add-on products installed. The remaining add-on
software can be set up now. Select from the following and click Next:

� Reconfigure All — The setup process is run again for the base Sun Management
Center software and all add-on software. All the Sun Management Center
software that was previously set up is set up again.

� Configure Addons — The add-on software that was recently installed, but not
yet set up, is now set up.

5. Review the list of products in the Setup Complete panel and click Next.

The Select Add-on Products panel appears. All products newly installed on the
system that will be set up are listed. You are also given the option to run setup
again on any product that has already been set up.

6. Confirm that Performance Reporting Manager appears as a product to be set up
now and click Next.

The Performance Reporting Manager setup progress bar appears.

� If you are setting up the agent layer, after the progress bar is done go to Step 10.

� If you are setting up the server layer, the Performance Reporting Manager DB
Size panel appears after the progress bar is done. Go to Step 7.

7. From the Performance Reporting Manager DB Size panel, provide the desired
database size by selecting Small, Medium, or Large, and click Next.

The three sizes are based on the number of agent machines and data properties you
will monitor. For more information, see “Performance Reporting Manager
Software” on page 21.

8. Provide the full path to three directories in the Performance Reporting Manager
DB Directories panel and click Next.

You are prompted in a single panel for three data file locations. While you can use
the same directory three times, try to use three different directories located on three
different file systems. This separation reduces disk I/O contention and results in
better product performance.

The space required depends upon the size of the configuration you choose during
setup. The data file locations require disk space as listed in the following table.

Configuration Size First Directory Size Second Directory Size Third Directory Size

Small 2048 Mbytes 1536 Mbytes 1536 Mbytes
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Configuration Size First Directory Size Second Directory Size Third Directory Size

Medium 5120 Mbytes 4096 Mbytes 3072 Mbytes

Large 8192 Mbytes 7168 Mbytes 7168 Mbytes

The Performance Reporting Manager DB Configuration Panel appears.

9. Once the progress bar in the Performance Reporting Manager DB Configuration
Panel completes, click Next.

Configuration of the database takes approximately 15 minutes to complete. Once
done, the Add-on Products Setup panel appears.

10. To invoke the start wizard, click Next.

Once the setup procedure is complete, you have the option to start the Sun
Management Center processes. For more information, see the Sun Management
Center 3.6 Installation and Configuration Guide.

Before Generating Reports
Once you have completed installation and setup, you must start the Sun Management
Center server. You can choose to start the server either after the setup process is
completed, or manually later on. For more information about starting the server, see
the Sun Management Center 3.6 Installation and Configuration Guide.

You cannot generate reports until data is being logged and collected. For more
information about how data is collected, see “Data Collection Process” on page 12. For
more information about enabling the logging of data, see “Data Properties Logging”
on page 56.

Backup and Restore
Use the Sun Management Center backup and restore scripts to back up or restore all
Sun Management Center data, including Performance Reporting Manager. For
information, see the Sun Management Center 3.6 Installation and Configuration Guide.

Performing frequent backups of your entire system enables you to recover the most
current data possible, in the event of a system failure. Frequent backups will help to
minimize any data loss.

See Also
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Caution – If you restore from a backup made before the Performance Reporting
Manager software is set up, you lose your Performance Reporting Manager data.

Caution – Do not attempt to restore a backup from a medium or large configuration if
the machine has been converted to a small configuration. Problems might result from
having insufficient disk space to restore the data, and you might experience
performance degradation. This type of restoration is not supported.

Caution – Do not attempt to restore a backup from any configuration to a machine that
has a configuration of a different size. This type of restoration is not supported.

Agent Update Feature
Sun Management Center Agent Update feature enables you to update the agent layer.
An update image is created on the server machine that is specified as the server
context for the agent machines. Before using the Agent Update feature, the
Performance Reporting Manager server layer must be installed on the server machine
that is specified as the server context. The update image wizard prompts you to select
from the list of products to include in the update image. You must select Performance
Reporting Manager for inclusion in the update image. You must provide the server
context for the agent machine when the update image wizard prompts you. For
information about using the Agent Update feature, see the Sun Management Center 3.6
Installation and Configuration Guide.

Upgrading Performance Reporting
Manager
If you have Performance Reporting Manager 3.0, 3.5, or 3.5 Update 1 installed on your
system, the earlier software must be uninstalled as part of the upgrade procedure. If
you want the Performance Reporting Manager data to be upgraded to version 3.5
Update 2, do not use the es-uninst script to uninstall the earlier software. This
script does not offer you the choice to preserve the data from the previous version.
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Instead, use the Sun Management Center installation wizard to remove the previous
version software while installing the Sun Management Center software. The Sun
Management Center installation wizard asks whether you want to preserve your
previous version data files before removing the software. If you want to preserve your
data files, answer Yes to this question. The installation wizard then proceeds to install
the Sun Management Center software, and prompts you to select add-on products to
install. You must say Yes to the installation of the Performance Reporting Manager 3.5
Update 2 software. The previous version data will be upgraded to version 3.5 Update
2 as long you install Performance Reporting Manager during the installation of Sun
Management Center.

Note – If you are upgrading the Sun Management Center server, the machine must
have either the Solaris 8, Solaris 9, or Solaris 10 developer environment installed.

For more information about upgrading your Sun Management Center software,
including detailed procedures, see the Sun Management Center 3.6 Installation and
Configuration Guide.

Uninstalling Performance Reporting
Manager
Use the Sun Management Center uninstall wizard to remove the Performance
Reporting Manager software. The uninstall wizard removes both the Performance
Reporting Manager packages and all the Performance Reporting Manager data and
configuration changes made during setup. The Sun Management Center uninstall
wizard gives you the option to save the existing data. Your selection regarding the
saving of data applies to all the products chosen to uninstall at the same time. For
more information about using the uninstall wizard, see the Sun Management Center 3.6
Installation and Configuration Guide.

� To Remove the Performance Reporting Manager
Software

Note – From a Microsoft Windows system, start the uninstall process from
C:>\Program Files\SUNWsymon\SunMC3.5\SunMCUninst.bat.
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1. As superuser (su -), start the uninstall wizard by typing:

# /opt/SUNWsymon/sbin/es-guiuninst

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

The Sun Management Center uninstall wizard appears.

2. Select Performance Reporting Manager from the list of software, and click Next.

3. Indicate whether to preserve the data files, and click Next.

The Performance Reporting Manager packages and configuration files are
removed. If you chose not to preserve the data files, these files are removed as well.

4. Click Close to exit the wizard.

Steps
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CHAPTER 3

Standard Reports

This chapter discusses the following topics:

� “Standard Reports Overview” on page 33
� “Report Manager GUI” on page 37
� “Generating Reports” on page 38

Standard Reports Overview
Performance Reporting Manager includes 16 standard reports with predefined options
that you cannot edit. A standard report has predefined report options that generate a
report that is generally useful to anyone monitoring a system. The report output
format is also predefined and cannot be changed.

Standard reports are organized by category and subcategory in the left pane of the
Report Manager GUI. Standard report requests are identified by the lock symbol that
appears on the report request icon. The lock reminds you that you cannot change the
predefined report options.

All standard reports generated by Performance Reporting Manager are classified as
being either a performance report or a system configuration report. A performance
report tracks properties that are numerical and change over time. An example of a
performance report is a graph that shows the percentage of CPU kernel usage on a
host over the last 24 hours. For more information about standard performance reports,
see “Standard Performance Reports” on page 34.

A standard system configuration report provides data detailing the state of the
configuration on that machine. An example of a system configuration report is a table
that summarizes all the patches currently installed on one or more machines. For more
information about standard system configuration reports, see “Standard System
Configuration Reports” on page 35.
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The output from all standard reports can be viewed in the Sun Management Center
Java console, in a web browser as an HTML file, or in a comma-separated value (CSV)
or tab-separated value (TSV) ASCII text file. The text file can be used with other tools
to analyze the data. See “Options for Viewing Report Output” on page 67 for more
information.

For a detailed list of properties that each standard report incorporates, see “Standard
Performance Reports” on page 34, “Standard System Configuration Reports” on page
35, or Appendix A.

Note – You must have the Kernel Reader Simple module loaded before you can run
any standard report.

Standard Performance Reports
Performance data logging on agent machines is provided by the history logging
capability included with Sun Management Center. Performance Reporting Manager
collects only the data logged in the history log files. The data then is transferred to the
Sun Management Center server machine and loaded into the database. Report data is
obtained by making queries to the database to determine trends in the performance
statistics over a specified time period.

Data for system uptime and downtime reports is obtained from the /var/adm/wtmpx
file, which collects output from such commands as shutdown and init. Data is
collected every five minutes by Performance Reporting Manager to account for system
downtime caused by power outages or other commands that do not update the wtmpx
file. If an event does not add an entry to this file, the last known timestamp is used as
an approximate record for computing system downtime.

The report options are predefined in the standard performance report requests. The
report output format for all standard performance reports is a graph. The following
standard performance reports are included with Performance Reporting Manager. The
list is organized by the category and subcategory names of the reports.

� Performance

� CPU

� CPU Utilization – This report lists the CPU utilization for the last 24 hours
using the Maximum function. The report includes the % CPU kernel time,
and % CPU user time data properties. You provide the host name and port
when the report is run.

� Overall CPU Utilization – This report lists the overall CPU utilization, given
as an aggregation, for the last 24 hours. The report includes the Overall
Percentage CPU utilization data property. You provide the host name and
port when the report is run.
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� Swap

� Swap Available – This report lists the swap space available on each host over
time. The report includes the available memory in Kbytes (anon memory not
reserved) data property. You provide the host name and port when the
report is run.

� Memory

� Memory Free – This report lists the amount of physical memory free in
megabytes on each host over time. The report data includes the amount of
physical memory free in Mbytes. You provide the host name and port when
the report is run.

� System Uptime

� Uptime Status – This report provides the uptime status of the host for the
last calendar month. You provide the host name and port when the report is
run.

� Percent Uptime – This report provides the percentage of uptime for a host
for the last seven days. When a Detailed report is requested, this report
includes the average of the percentage of uptime and the percentage of
downtime for the system. When a Total report is requested, the report data
is the percentage for a system for the specified date range. The report data
includes the percentage uptime for the host displayed on a graph, with a
data point shown for each day. You provide the host name and port when
the report is run.

� Total Uptime – This report provides the total uptime in hours for a host for
the last seven days. When a Detailed report is requested, this reports
includes the summed uptime and downtime values in hours. When a Total
report is requested, the total number of hours that a system was up is given
for a specified date or time period. The report data includes the system
uptime for the system. You provide the host name and port when the report
is run.

Standard System Configuration Reports
System configuration data is logged on the agent machines by the Performance
Reporting Manager logging component. This logging component is added to the agent
machine during installation. The data is then transferred to the Sun Management
Center server machine and loaded into the database. Report data is obtained by
making queries to the database located on the Sun Management Center server
machine. This method is similar to the way the data for standard performance reports
is obtained.

The report options are predefined in the report request. The report output format for
all standard system configuration reports is a table. The following standard system
configuration reports are included with Performance Reporting Manager. The list is
organized by the category and subcategory names of the reports.
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� Alarm

� Alarms

� Alarm Details – This report lists all open alarms for each host. The report
data includes host name, operating system, alarm severity, alarm status,
open date, and alarm message. You provide the host name and port when
the report is run.

� Alarm Summary – This report lists the alarm status and alarm count for
each host. The report data includes the host name and alarm status. The
report provides detail for all hosts in the server context.

� Alarm Severity Count By Host – This report lists the alarm severity count
for each host. The report data includes the host name, alarm severity, and
alarm status. The report provides detail for all hosts in the server context.

� Hardware

� System

� System Details – This report lists the system details by host name. All hosts
in the server context that have both the Config-Reader add-on and
Performance Reporting Manager installed are included. The report data
includes the host name, operating system, system clock frequency, platform
type, total disks, total memory, total processors, and total tape devices.

� Platform Summary – This report lists the platform type by host name. All
hosts in the server context that have the Config-Reader add-on and
Performance Reporting Manager installed are included. The report data
includes platform.

� OS Summary – This report lists the operating system by host name. All hosts
in the server context that have the Config-Reader add-on and Performance
Reporting Manager installed are included. The report data includes the
operating system.

� Configuration
� Software

� Packages

� Hosts with SUNWcsr package – This report lists the hosts that have the
SUNWcsr package installed. The report data includes the host name,
package instance, package name, category, version, package description, and
install date. The report provides detail for all hosts in the server context.

� Package Details – This report lists all the software packages installed on a
specified host. The report data includes the host name, package instance,
package name, category, version, package description, and install date. You
provide the host name and port when you run the report.

� Patches

� Patch Details – This report lists all the software patches installed on a
specified host. The report data includes the host name, operating system,
patch id, packages, obsoletes, requires, and incompatibles. You provide the
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host name and port when you run the report.

You can resize the columns in any tabular report by dragging the sides of the column
header. Additionally, you can sort any tabular report by double-clicking the column
headers. The report then sorts according to the header selected.

Report Manager GUI
You manage all report activity through the Report Manager graphical user interface
(GUI). For example, you can generate a report from a report request, create a new
custom report request, or schedule a report to generate at regular intervals. The Report
Manager GUI is linked to the Sun Management Center Java console only. The GUI is
opened from the Tools menu in the Sun Management Center console.

Report Manager displays information in two panes. The left pane contains the
hierarchy view of the report requests. The report requests are organized by category
and subcategory. For more information about categories and subcategories, see
“Categories and Subcategories” on page 15.

The right pane in Report Manager contains summary fields. These summaries help
you to quickly identify the important distinguishing characteristics of each report
request. After selecting a request name from the hierarchy view in the left pane, the
following information is displayed in the right pane:

� Report Request – The name and description of the report request

� Data Properties – The list of data properties selected for the report request

� Hosts – The host names included in the report

� To Start Report Manager

1. Start the Sun Management Center console.

2. Choose Report Manager from the Tools menu.

The Report Manager GUI appears. The hierarchy view is in the left pane, and the
report request summary appears in the right pane after a report request is selected.

3. Click the key symbol next to a category name to expand the hierarchy view.

The hierarchy view expands one level to display the subcategory name. The report
requests are identified by the report request name, and are located under the
subcategory name.

Steps
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Sample of Report Manager With Details Showing for a Standard
Report

The following figure shows a sample of what the Report Manager GUI contains when
a standard performance report is selected from the hierarchy view. The left pane
shows that the CPU Utilization report request is selected in the hierarchy view. The
right pane displays a summary of some of the report options for the CPU Utilization
report request. The detail fields include Report Request, Data Properties, and Hosts.
The detail for each field provides a summary of the options that are predefined in the
report request.

Generating Reports
You can generate a standard report in one of three ways:

� By choosing Generate from the File menu in Report Manager.

� By double-clicking the name of the report request from the left pane in Report
Manager.

� By clicking the Generate icon in the menu. This is the first icon located under the
menu options.

Example 3–1
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After you generate the report, you can print the report and specify several printing
options. Each time you generate a standard performance report, you must provide the
host name and corresponding port if this information is not predefined. The host
name is not saved to the report request. You can specify a different host name each
time you generate a standard performance report.

For standard system configuration reports, a report is generated for all hosts identified
in the Sun Management Center server context that also have the Performance
Reporting Manager software installed.

For more information about standard performance and system configuration report
requests, see “Standard Reports Overview” on page 33.

Both standard and custom reports are generated this way. For information about
scheduling reports to run at regular intervals, see “Scheduling Reports” on page 66.

� To Generate a Standard Report

Note – You must have the Kernel Reader Simple module loaded in order to run any
standard performance report.

1. Start Report Manager.

2. Select the name of the desired report request from the hierarchy view.

Verify that this report request is correct by reviewing the summary information
contained in the right pane.

3. Choose Generate from the File menu, or double-click the name of the report
request from the hierarchy view.

The standard report is generated. A second window opens that contains the report
output. For information about when data is available for reports, see “Data for
Reports” on page 14.

4. If a dialog box appears, provide the host name and corresponding port.

� To Print a Report
After generating the report, you can print the report and save it to a file.

1. From the File menu, choose Print Screen.

The Print dialog box appears.

Steps
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2. From the General tab, you can do the following:

� From the Name pull-down list, choose a printer.

� (Optional) Select Print to File.

If you select Print to File and then click Print, a Print to File dialog box appears.
Accept or change the default path and file name. The output file type is
PostScript™.

� (Optional) Enter a print range.

� (Optional) Enter the number of copies.

3. To change the page set up, click the Page Setup tab. From this tab, you can do the
following:

� (Optional) From the Size pull-down menu, choose a paper size.

Options include Letter (default), Tabloid, Legal, Ledger, Executive, A3, A4, A5,
B3, and B4.

� (Optional) Choose an orientation.

� (Optional) Specify left, right, top, and bottom page margins.

4. To change the appearance of the printed report, click the Appearance tab. From
this tab, you can do the following:

� (Optional) Choose color or monochrome.

� (Optional) Choose print quality (draft, normal, high).

� (Optional) Choose side orientation (one side, tumble, duplex).

� (Optional) Choose job attributes (banner page, priority, job name, user
name).

5. Click Print.
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CHAPTER 4

Custom Reports

This chapter discusses the following topics:

� “Custom Reports Overview” on page 41
� “Adding a New Category or New Subcategory” on page 42
� “Custom Report Templates” on page 43
� “Data Properties” on page 51
� “Data Collection Options” on page 61
� “Filtering Reports” on page 63
� “Composite Report Requests” on page 63

Custom Reports Overview
Performance Reporting Manager enables you to create your own custom reports. You
use one of the report templates provided to create custom reports. When you select a
report request type from the menu, the correct template is automatically displayed.
The report templates contain similar options, but there are differences between them.
For more information about the fields contained in the report templates, see “Custom
Report Templates” on page 43.

Unlike a standard report in which the report output format is predefined, you can
specify the output format when creating a custom report. The possible output options
are a table, a line graph, a bar chart, a pie chart, an area chart, or a text file. At the time
you complete the report template, you are offered only the valid output options for the
type of report request you are creating. For more information about report format
options, see “Output Format Options for Reports” on page 16.

Before creating a custom report, you should be familiar with how Performance
Reporting Manager collects the data that is polled for reports. For more information,
see “Data Collection Process” on page 12.
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Adding a New Category or New
Subcategory
You can place reports under a predefined category or add a new category and new
subcategory to the report hierarchy. For more information about the predefined
options, see “Categories and Subcategories” on page 15.

New categories are added to the bottom of the list in the hierarchy view. Each new
subcategory is added to the bottom of its corresponding category.

� To Create a New Category

1. Start Report Manager

For the detailed steps, see “To Start Report Manager” on page 37.

2. From the File menu, choose New, then select Category.

The Create Category dialog box appears. It contains two text fields.

3. Type the new category name in the Name field.

4. (Optional) Type the description of the category in the Description field.

5. Click OK to finish adding the category to the hierarchy view.

When the category name is selected, the name and description appear in the
Report Category summary in the right pane.

� To Create a New Subcategory

1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 37.

2. From the File menu, choose New, then select Subcategory.

The Create Subcategory dialog box appears. It contains two text fields.

3. Select the desired Category from the drop-down menu.

4. Type the new subcategory name in the Name field.

5. (Optional) Type a description of the subcategory in the Description field.

Steps

Steps
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6. Click OK to finishing adding the subcategory.

The new subcategory name appears at the second level in the hierarchy view,
beneath the category name. When the subcategory name is selected, the name and
description appear in the Report Subcategory summary in the right pane.

Custom Report Templates
A report template guides you through the process of creating your own custom report.
The report fields displayed are predefined in the report template according to the type
of report you want. A saved report template containing the options you select for your
custom report is called a report request. All custom report requests are based on one of
the report templates that are included with Performance Reporting Manager.

Small differences exist between the report templates depending upon the type of
request you want to create: a custom performance report or a custom system
configuration report. Performance reports are based on properties that yield numerical
results and that change over time. The data returned can be plotted over time in a
graph, for example. This graph can then be used to determine trends in performance
of the machines. The system configuration reports provide data regarding the details of
the hardware and software configuration of the host.

When you choose a report request from the File menu in Report Manager, a report
template is automatically displayed in a dialog box. The template displayed depends
upon the type of report request you choose. The following report templates are
available:

� Performance Report Request – Reports that provide information regarding system
resource utilization, such as the amount of disk space or processor used.

� System Report Request – Reports that provide basic information on system
capacity, such as the number of disks or processors on a host.

� Hardware Configuration Report Request – Reports that provide detailed
information on the host. For example, the report might detail the specifics about
each processor or each disk on a host.

� Package Report Request – Reports that provide information about the software
packages installed on a host.

� Patch Report Request – Reports that provide information about the software
patches installed on a host.

� Alarms Report Request – Reports that provide information about the status of
alarms on a host.

� System Uptime Report Requests – Reports that provide information about a
system’s uptime and downtime.
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The fields available in a report template are described below. The report field
descriptions are grouped according whether the fields are found in both types of
reports, only in performance reports, or only in system configuration reports.

Common Custom Report Fields
The fields that can be common to both performance and system configuration reports
are:

� Category
� Subcategory
� Report Request
� Report Title
� Data Properties
� Selected Hosts
� Output Mode
� Customize

Category
Select the desired category from the Category drop-down menu. New categories you
create also appear in the drop-down menu. This field determines where in the
hierarchy view the saved report request appears.

Subcategory
The Subcategory field is optional. Select the desired subcategory from the drop-down
menu. New subcategories that you create also appear in the drop-down menu.

Report Request
Provide the name of the report request. This name appears as the title in the report
request. The name also appears in both the report summary and the hierarchy views
in Report Manager.

Report Title
The Report Title field is optional. This field provides a description of the report that
then appears as the title. This description appears in the report summary of Report
Manager. The report summary is displayed when the name of the report is selected in
the hierarchy view.
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Data Properties
Select the data properties to be included in the report in the Data Properties field.
Click Edit to make your selections from the Select Data Properties dialog box. Some
differences exist between the Select Data Properties dialog box that is displayed in the
performance or system configuration report templates. The correct dialog box
automatically opens for you. Only the data properties currently being logged on the
hosts return data. For more information, see “Data Properties” on page 51.

Selected Hosts
Specify the hosts and corresponding port that you want to include in the report. Only
agent machines that have the software installed, that are in the server’s topology, and
that are linked to the server context return data. If no port is specified for a host, the
default port 161 is assigned. The following list describes the host choices:

� Enter Hosts at Run Time – You must provide each host and corresponding port
when you run the report request. A separate dialog box for this purpose is
displayed at runtime. You can also provide the IP address for the host and
corresponding port. The host and corresponding port are not saved to the report
request, and can be changed each time the report is run.

� Select Hosts From Main Console Window (Then Click Update) – The hosts and
corresponding ports that you provide are saved to the report request. Each time the
report is run, data is returned regarding the hosts originally saved. To select the
desired hosts, do the following:

� Go to the Sun Management Center Main Console window.

� Make your selections either by pressing Shift+Click, or by drawing a lasso
around the icons that represent the desired hosts.

� Click Update in the report template to add the hosts.

� Enter Hosts as Hostname:Port (Comma Delimited) – If selected, you provide the
host and the corresponding port. You can also provide the IP address for the host
and corresponding port. The proper form is to use a comma delimiter without a
space. You can add as many valid hosts and ports as wanted.

� All Hosts

Output Mode
Choose the desired format of the report from the Output Mode drop-down menu. The
available options depend on the type of report request you are creating. The following
list describes the possible options:

� Line Graph
� Bar Chart
� Stacked Bar Chart
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� Area Chart
� Stacked Area Chart
� Pie Chart
� Tabular
� Comma Separated Text
� Tab Separated Text

For more information about the report formats available, see “Output Format Options
for Reports” on page 16.

Customize
The Customize field is optional. You can further customize the look of a graph report
through the Customize dialog box. For more information, see “Customizing the
Appearance of Reports” on page 71.

Performance Report Fields
Three report fields are found only in a performance report template:

� Function
� Time Range
� Graph Orientation

The other possible fields available for this type of report are as described in “Common
Custom Report Fields” on page 44.

Function
The Function field controls the type of data that appears in the report. Select the type
of data you want from the drop-down menu. For more information about how data is
collected, see “Data Collection Process” on page 12. The following list describes the
function choices:

� Raw – The raw data logged on the agent machine is returned. Raw data is logged
according to the time interval specified in the Property Logging Setting dialog box
for each data property. The Raw option is available only for these standard time
ranges: Last 4 Hours, Last 24 Hours, Last 3 Days, and Real Time. If the Raw option
is chosen for a custom time range, a maximum of three days of raw data is
available.

� Maximum – The maximum value of the most granular level of data available in the
database is returned.

� Average – The average value of the most granular level of data available in the
database is returned.
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� Minimum – The minimum value of the most granular level of data available in the
database is returned.

Time Range
This field determines the time span of the report. The following list describes the time
range choices:

� Standard: Select a predefined time range from the drop-down menu. Choose from
the following time ranges:

� Last 4 Hours – The range starts from the current hour to minus four hours.

� Last 24 Hours – The range starts from the current hour to minus 24 hours.

� Last 3 Days – The range starts from 12:00 a.m. three days before the current date
to 11:59 p.m. the day before the current date.

� Last 7 Days – The range starts from 12:00 a.m. seven days before the current
date to 11:59 p.m. the day before the current date.

� Last Calendar Week – The range starts from 12:00 a.m. Sunday of the previous
week to 11:59 p.m. of the following Saturday.

� Last Calendar Month – The range starts from 12:00 a.m. of the first day of the
last month to 11:59 p.m. of the last day of the last month.

� Real Time – The range starts from the current day and time and goes forward.
This option is only available when the Function selection is Raw.

� Custom: Use this option to define your own time range.

First click Edit and then type a Date and Time Range in the Time Range dialog box.

The From and To fields contain drop-down menus from which you make your
selections.

Graph Orientation
If you select Line Graph or Bar Chart as the output mode, you must choose the
desired orientation of the graphs in the report. The following list describes the graph
orientation options:

� One Host, Many Data Properties – A separate graph for each host included in the
report is displayed. Each graph shows all the data properties for that host. Each
data property is shown as a separate line or bar on the graph. Each line or bar is
distinguished by either its color or its symbol, or both identifiers. The legend for
the graph identifies which color or symbol is being used for each data property in
the report. The host name is listed at the top of each graph.

� One Data Property, Many Hosts – A separate graph for each data property
included in the report is displayed. Each graph includes a separate line or separate
bar for every host in the report. Each line is distinguished by its color, or its
symbol, or both identifiers. The legend for the graph identifies which color or
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symbol is being used for each host in the report. The data property is listed at the
top of each graph.

� All Hosts and Data Properties on One Graph – Only one graph is displayed. All
hosts and data properties in the report are included. Each line or bar is
distinguished by its color, its symbol, or both identifiers. The legend for the graph
identifies which color or symbol is being used to identify each host and data
property in the report.

Custom System Configuration Report Fields
The report template for creating a custom system configuration report has two fields
that are found in this type of report:

� Level of Detail
� Filter

The other possible fields available for this type of report are as described in “Common
Custom Report Fields” on page 44.

Level of Detail
Use the Level of Detail field to determine the amount of detail wanted in the report.
Accept either the default (Detailed) or select Summary. If you select Summary, the
following information is returned:

� Alarm Reports – The number of alarms
� Hardware Reports – The number of hosts
� Packages Reports – The number of packages
� Patch Reports – The number of patches

When requesting a System Uptime report, the level of detail options are as follows:

� Detailed – Data is represented as one point per day or week, depending upon the
time period requested.

� Total – Data is represented as one point for the entire time period requested.

Filter
The Filter field is optional. Click Set Filter to select the desired filter options from the
Filter dialog box. Use the drop-down menus to build an expression that creates the
report filter wanted. The filtering options are case sensitive. For more information, see
“Filtering Reports” on page 63.
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Creating or Modifying a Report Request
You can create your own custom report request by one of the following methods:

� Copying a standard report request, and then modifying the predefined report
options in the copy

� Setting the desired report options in a new report request template

Once you save a custom report request, you can later make changes by using the
Modify dialog box.

� To Create a New Report Request by Modifying a
Standard Report Request

1. Start Report Manager.

For more information, see “To Start Report Manager” on page 37.

2. Select the name of the standard report request from the hierarchy view.

3. From the Edit menu, choose Copy.

4. Select the category or subcategory name under which you want the new report
icon to appear.

5. From the Edit menu, choose Paste.

The copied report icon appears at the bottom of the selected category or
subcategory. The name of the report is “Untitled” followed by a number.

6. From the Edit menu, choose Modify.

A report request dialog box appears with the options of the original standard
report already completed.

7. Type the new name of the report request in the Report Request field.

8. Make the desired changes to the report option. Click OK to save your changes.

The new report name replaces “Untitled” in the hierarchy view.

� To Create a New Report Request

1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 37.

Steps

Steps
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2. From the File menu, choose New, then select the desired report request type.

The report template specific to the type of report that you selected opens.

3. Complete the fields of the report template.

For more information about the report template options, see “Custom Report
Templates” on page 43. The hostname must match the name that appears in the
Data Collection window.

4. (Optional) Click Preview to see a preview of the report.

A preview of the report output is displayed in a new window. The data that has
already been collected is used for a report preview.

5. Click OK to save the report request.

The report request is now saved. The title of the report request appears, with the
corresponding report format icon, in the hierarchy view under the category and
subcategory selected. This report request is available until it is deleted.

� To Modify a Report Request

1. Start Report Manager.

For the detailed steps, see “To Start Report Manager” on page 37.

2. Select the name of the report request that you want to modify.

3. From the Edit menu, choose Modify.

The Modify dialog box opens. The fields contain the current values for Data
Properties, Time Range, Filter, and Selected Hosts.

4. Make your changes to the fields.

5. Click OK to save your changes to the report request.

Sample New Performance Report Request Template

The following figure is a sample of a New Performance Report Request template.

Steps

Example 4–1
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Data Properties
The ability to log data is included with the Sun Management Center base product.
Performance Reporting Manager uses this logged data in the reports. Only data that is
logged to the history log files on the agent machine is collected for reporting purposes.
Data cannot be included in any report until logging of the data property is first
enabled. Certain data properties are automatically logged for you. If a property is not
being logged, you do not receive any data for that property until logging is first
enabled. For more information, see “Data Properties Logging” on page 56.
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You can use the Data Availability option to determine whether a property is being
logged on the machine. Use the history logging capability of Sun Management Center
to either enable or disable the logging of a data property. You can also use the group
logging task. For more information about history logging, see Sun Management
Center 3.6 User’s Guide. For more information about the group logging task, see
“Group Logging” on page 57

If you receive a No Data Found error message when running a report, first check to
see whether the data property is being logged on the agent machine specified in your
report. For more information, see “Data Collection Options” on page 61. If logging is
enabled, check to see if the data property is being logged from the Data Availability
window. For more information, see “To View the Data Properties Logged for a Host”
on page 52.

Data Availability
Only those data properties that are being logged on the agent machine can return data
for reports. Data logging must be enabled for these properties. The Data Availability
dialog box enables you to check data properties per host for which logging is enabled.
Information for inactive hosts is also provided. Inactive hosts are those that might no
longer be in the topology or might not be in the server context but still have historical
data in the database.

Information is available through the following three tabs: Collection Enabled,
Collection Disabled, and Inactive Hosts. Each tab contains two tables. The first table
lists the host name with corresponding port, and the latest time data was collected.
The second table lists information about the data properties, including the property
name, index number, module name, and module instance. Properties for which data
was collected in the last collection cycle for the host is displayed. The table expands to
list all the data properties collected for that host. You can resize the columns by
dragging the cell borders in the column title. You can sort the table by double-clicking
the column headings.

The information in the tables is updated every hour, except for Inactive Hosts or hosts
for which collection has been disabled. If you have just installed Performance
Reporting Manager, the data might take an hour to first appear in the Data Availability
dialog box.

Note – The data properties being logged are used for performance reports only.

� To View the Data Properties Logged for a Host

1. From the Report Manager file menu, choose Data, and then select Data
Availability.

The Data Availability dialog box opens.

Steps
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2. Select the desired tab.

� Collection Enabled – Select for information about hosts that have data collection
enabled.

� Collection Disabled – Select for information about hosts that have data
collection disabled.

� Inactive Hosts – Select for information about hosts that are no longer active and
for which historical data is still available.

3. From the first table, select the row for the desired host.

The data properties for that host are displayed in the second table.

4. Click Close to dismiss the dialog box.

Sample of the Data Availability Dialog Box with Data Properties
Showing

The following figure shows a sample of the Data Availability dialog box.

Example 4–2
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Data Properties Selection
When creating your custom report request, the report template requires that you select
the data properties to include in the report.

The addition of certain properties requires that you provide an entry for either the
module instance or property instance, or both instances. The module instance is needed
only for multi-instance modules. Examples of a multi-instance module include File
Monitoring or Directory Monitoring. Each instance can be used for monitoring a
different file or different directory.
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The property instance typically refers to an instance name given to the property being
logged. For example, in a machine with four CPUs, the CPUs can be numbered 0, 1, 2,
and 3. If you want the performance of CPU number 3, you specify 3 as the property
instance for the CPU property. You specify All as the property instance when you want
a report that includes all instances that exist for the host. For more information, see the
Sun Management Center 3.6 User’s Guide

� To Add Data Properties

1. From the Data Properties field in the New Report Request template, click Edit.

The Select Data Properties dialog box appears. It contains two panes. The left pane
is titled Properties to Choose From. The right pane is titled Selected Properties.

2. Expand the hierarchy view in the left pane by clicking the key symbols.

The data properties are located at the third level of the hierarchy.

3. Select the desired property, and click Add.

The property moves to the right pane. If required, the Module Instance or Specific
Property Index fields become active in the lower left corner of the dialog box.

4. (Optional) Provide the Module Instance and Specific Property Index in their
respective text fields.

If module is a multiple instance module, provide the module instance wanted.

5. When you finish adding all desired properties, click OK.

The Select Data Properties dialog box closes. Continue completing the report
template.

Sample of the Select Data Properties Dialog Box for a Performance
Report Request

The figure below shows a sample of the Select Data Properties dialog box for
performance reports.

Steps

Example 4–3

Chapter 4 • Custom Reports 55



Data Properties Logging
You can enable the logging of a single data property, or you can enable the logging of
many data properties on many hosts at the same time. The second method is called
group logging, and is done by using the Manage Jobs features of Sun Management
Center. For more information about group logging, see “Group Logging” on page 57.

You must enable the logging of a single data property from the Sun Management
Center console.
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� To Enable Logging of a Single Data Property

1. From the Sun Management Center console window, select the host name from
the hierarchy.

The Details window appears.

2. From the left pane, select the desired module from the hierarchy view.

The hierarchy view expands to reveal table names underneath.

3. Double-click the desired table name.

A table appears in the right pane. Each row contains a data property. More than
one table can appear, depending upon the module.

4. Select the row containing the desired data property, and press mouse button 3.

A pop-up menu appears.

5. Choose Attribute Editor.

The Attribute Editor dialog box appears.

6. Select the History tab.

7. Select Save History as Disk File.

8. From the File Type drop-down menu, choose Circular File.

9. Click OK to close.

Data logging is now enabled on the data property.

Group Logging
Use the Manage Jobs features of Sun Management Center to enable logging of the
same data properties on a group of agent machines. This feature is called group
logging. Instead of adding the same set of data properties to be logged on each
machine individually, you can save time with group logging by using the Manage Jobs
dialog box to do the following task:

� Create a data logging task.
� Create a job that contains the data logging task.
� Run the job.

After you install the Performance Reporting Manager software, the Manage Jobs
features of Sun Management Center are enhanced, and a new option appears in the
New Task dialog box. This new option is Data Logging. Data Logging appears in the
Show Task Type and Task Type drop-down menus. When Data Logging is selected as
the Task Type, the Logging Setting button appears next to the Data Properties table.
The logging of data properties is enabled with the Property Logging Setting dialog

Steps
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box. You access the Property Logging Setting dialog box from the Logging Setting
button. You can also change the interval time properties are logged at the same time.
The default logging interval is 300 seconds. For more information about the Manage
Jobs features, see Chapter 13, “Managing Group-related Jobs,” in Sun Management
Center 3.6 User’s Guide.

� To Create a Data Logging Task

1. From the Sun Management Center main console File menu, choose Tools, then
select Manage Jobs.

The Manage Jobs dialog box appears.

2. From the Task field, click New Task.

The New Task dialog box appears.

3. Type the name of the new task in the Task Name text field.

4. From the Task Type drop-down list, select Data Logging.

5. Click Add Properties.

The Select Data Properties dialog box appears.

6. From the Properties to Choose From panel, select the data properties one
property at a time. Click Add after each property.

The data properties are contained in the third level in the hierarchy. As each data
property is added, the name moves to the right pane. Provide the Module Instance
and Property Index information when required.

7. Click OK when done.

The data properties are added to the task.

8. In the New Task dialog box, select the row that contains the data property.

If you added more than one data property to the task, you must select one row at a
time. The Logging Setting button is enabled.

9. Click Logging Setting.

The Property Logging Setting dialog box appears.

Steps
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10. Select Logging if it is not already selected.

The data property is now being logged.

11. Type the desired time interval, in seconds, in the Interval text field.

The default is 300 seconds. The data property is logged at the interval specified.

12. Click OK to save your changes.

The Property Logging Setting dialog box is dismissed.

13. In the New Task dialog box, click Add Task to save.

14. To dismiss the New Task dialog box when finished, click Close.

� To Define a Job

� For the detailed steps, see “To Define a Job” in Sun Management Center 3.6 User’s
Guide.

Note – When specifying the task in step 6 of the To Define a Job procedure, click
Data Logging. Be sure to select the Data Logging task that you defined to enable
logging. Data logging is enabled when the job is actually executed. Follow the
remainder of the procedure.

� To Disable Logging of a Single Data Property

1. Access the Attribute Editor dialog box by completing Steps 1 through 7 of “To
Enable Logging of a Single Data Property” on page 57.

2. Deselect Save History as Disk File.

Step

Steps
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3. Click OK to save the change.

Logging of the data property is now disabled.

� To Disable Data Logging in a Data Logging Task

1. From the Sun Management Center main console File menu, choose Tools, then
select Manage Jobs.

The Manage Jobs dialog box appears.

2. From the Task field, click New Task.

The New Task dialog box appears.

3. Type the name of the new task in the Task Name text field.

4. From the Task Type drop-down list, select Data Logging.

5. Click Add Properties.

The Select Data Properties dialog box appears.

6. From the Properties to Choose From panel, select the data properties one
property at a time. Click Add after each property.

The data properties are contained in the third-level in the hierarchy. As each data
property is added, the name moves to the right pane. Provide the Module Instance
and Property Index information when required.

7. Click OK when done.

The data properties are added to the task.

8. From the New Task dialog box, select the row that contains the data property.

If you added more than one data property to the task, you must select one row at a
time. The Logging Setting button is enabled.

9. Click Logging Setting.

The Property Logging Setting dialog box appears.

10. Deselect Logging.

11. Click OK to save your changes.

The Property Logging Setting dialog box is dismissed.

12. In the New Task dialog box, click Add Task to save.

13. Click Close to dismiss the New Task dialog box when finished.

Steps
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Note – You must define a job with this task to complete the disabling of data logging.
For the detailed steps, see “To Define a Job” in Sun Management Center 3.6 User’s Guide.
When specifying the task in step 6 of the “To Define a Job” procedure, select the Data
Logging task that you defined to disable data logging. Data logging is disabled when
the job is executed.

Data Collection Options
You can use this screen to enable or disable data collection on a host. The Data
Collection dialog box lists the agent machines that have data collection enabled or
disabled.

Data collection on an agent machine is enabled by default when that host meets the
following requirements:

� The Performance Reporting Manager software is installed
� The host is in the Sun Management Center topology
� The host is in the server context

The table in the left pane displays the state of data collection when it is enabled on a
host, as well as the latest time that data was collected. An alert appears in the first
column if data collection did not occur in the last collection cycle. This situation can
occur if the host was not running during the last collection cycle, for example. If no
alert appears, data was collected on schedule. The final column lists the latest time
data was collected.

If you have just installed the Performance Report Manager software, collection time
might take an hour to appear in the table. Entries are added to this table continuously
as long as data collection is enabled. See the following figure for an example of the
Data Collection dialog box.

See Also
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FIGURE 4–1 Sample of Data Collection Dialog Box

When data collection is disabled, the host name and latest collection time appear in
the table in the right pane. This information remains until the Performance Reporting
Manager software is uninstalled, or the host is removed from the topology, or
removed from the server context.

You can stop data collection on any agent machine that you no longer need to include
in reports. Once data collection is disabled for a host, you can later enable it again
using this screen.

� To Enable or Disable Data Collection on a Host

1. From the Report Manager File menu, choose Data, and then select Data
Collection.

The Data Collection dialog box opens. All hosts for which data is not currently
being collected are listed in the right pane. All hosts for which data is currently
being collected are listed in the left pane.

2. Select the name of the host from the corresponding table.

3. Click the Enable, Enable All, Disable, and Disable All buttons to move the host
names as needed.

� To disable data collection, move the host name from the left table to the right
table.

� To enable data collection, most the host name from the right table to the left
table.

Steps
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4. Click OK to save the settings.

Filtering Reports
You can further modify the type of information that your custom report contains by
using the Filter feature. The Filter option is available for some custom system
configuration report requests.

The Filter dialog box contains several drop-down menus and text fields. Use them to
build an expression. This expression defines the report parameters to include in the
filter criteria wanted. The expression operators provided are common to the C
programming language. Filter options are case sensitive.

For example, you can create a custom system configuration report request to include
data on machines that are running the Solaris 7 or Solaris 8 versions of the Solaris
Operating System. You would create the following expression using the Filter dialog
box:

Operating System = SunOS 5.7
OR
Operating System = SunOS 5.8

As another example, you can create a custom system configuration report request to
include the machines that have the SyMON packages installed. You would create the
following expression:

Category contains SyMON

In order to include only those machines that have the Sun Management Center SyMon
packages installed, you can modify the above example this way:

Category contains SyMON AND Version contains 3.5

Composite Report Requests
Performance Reporting Manager enables you to combine two or more existing report
requests to create a new report request. The resulting report request is called a
composite report request. To create a composite report request, you can use existing
standard or custom report requests, or a combination of both types. A composite
report request combines the options of the report requests used. You specify a new
name for the composite report request. The report then is identified in the hierarchy
view under the category and subcategory selected.
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If the host name is not defined in any report request, you cannot select that request to
become part of a composite report request. For example, you cannot select any report
request for which the option Add Hosts at Runtime was specified.

You cannot delete or rename any existing standard or custom report request once it is
referenced by a composite report request. You must first delete the composite report
request.

� To Create a Composite Report Request

1. From the Report Manager File menu, choose New, then select Composite Report
Request.

The Composite Report Request dialog box opens.

2. Select the desired category and subcategory from the drop-down menus.

3. Type a name for the report in the Name field.

4. Select the desired reports from the left pane. Use the Add button to move the
reports to the right pane that is titled Selected Report Requests.

Use the Remove button if you select a report you do not want. The Remove All
button clears all selections from the right pane.

5. (Optional) Click Preview to see a preview of the report.

A preview of the report output is displayed in a new window. The data that has
already been collected is used for a preview of a report request.

6. Click OK to save the report request.

The composite report request is now saved. The title of the composite report
request appears in the hierarchy view under the category and subcategory selected.
This report is available until it is deleted.

Steps
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CHAPTER 5

Report Options

Performance Reporting Manager enables you to customize reporting capabilities.

This chapter discusses the following topics:

� “Report Options Overview” on page 65
� “Scheduling Reports” on page 66
� “Options for Viewing Report Output” on page 67
� “Accessing Reports From the Sun Management Center Web Server” on page 68
� “Line Graph Report Viewing Options” on page 70
� “Customizing the Appearance of Reports” on page 71

Report Options Overview
Performance Reporting Manager includes several options that enable you to
customize the reporting capabilities.

� You can schedule reports to automatically generate as needed.

� If you decide that you no longer need to monitor a particular host for a report, you
can stop collecting data on that host.

� The report output can be saved in HTML for viewing in a web browser.

� Reports can be saved in tab-separated or comma-separated values ASCII text form.

For more information about viewing reports in a web browser, see “Options for
Viewing Report Output” on page 67.
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Scheduling Reports
You can schedule any standard or custom report request to automatically generate at a
regular interval, as long as the host names are saved in the report request. The output
from all scheduled reports is posted to the Sun Management Center server machine.
The reports are saved in a directory on the server machine. You access these reports in
a browser at: http://server-machine-name:8080/prm/reports.

� To Schedule a Report

1. From the Report Manager File menu, choose Schedule, and then select Schedule
Report Generation.

The Schedule Report Generation dialog box opens.

2. Select the name of the desired report request from the hierarchy view contained
in the left pane.

The report requests are located at the third level in the hierarchy view.

3. Click the Add button.

The name of the report request moves to the right pane.

4. (Optional) Select Multiple Report Requests if you have more than one report to
schedule for the same time.

Select this option only if you want all the reports to run at the same time.

5. Complete the Date, Time and Repeat Interval fields.

The date format is specific to the locale. Provide the date as specified in the date
label. Make your selections for the Time and Repeat Interval fields from the
drop-down menu.

6. Click OK to schedule the report.

The report is now scheduled to generate according to your selections. The report
continues to generate at the interval specified until the request is deleted.

� To Remove a Scheduled Report

1. From the Report Manager File menu, choose Schedule, and then select View
Scheduled Report Status.

A new window opens with a table that contains the status of all reports currently
scheduled. You can resize the table columns by dragging the cell border of the
header title.

Steps
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2. Select the row that contains the name of the report to be removed.

3. Click Remove.

The report is removed from the table.

4. Click OK.

The report is no longer scheduled to be generated

Options for Viewing Report Output
After a report is generated, you have several options for viewing and saving the
output. These options include the following outputs:

� View a report as an HTML file in a browser. This option is helpful for printing the
report.

� Post any saved reports as HTML files to Sun Management Center Web server for
others to view.

� After a tabular or graphical report has been first generated, you can save the report
in a tab-separated value or a comma-separated value ASCII text file. This file can
then be used with other tools to analyze the data, for example.

Reports saved as an HTML file can be viewed using Netscape Navigator™ 4.5.1 or
higher, Mozilla™ 1.4 or higher, or Internet Explorer 5.0 or higher.

� To View a Report as HTML in a Browser

1. Generate the desired report.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 39.

2. Choose Show in Web Browser from the File menu in the report window.

The web browser launches and the report is displayed as HTML.

� To Post to a Sun Management Center Web Server

1. Generate the desired report request.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 39.

Steps
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2. Choose Post to a Web Server from the File menu in the report window.

The report is posted to the Sun Management Center server to which you are
connected, which acts as a web server.

� To Export Data

1. Generate the desired report.

The report output is shown in a separate window. For the detailed steps, see “To
Generate a Standard Report” on page 39.

2. Choose Export Data from the File menu in the report window.

The Export Data dialog box appears.

3. Select either Comma or Tab as the delimiter.

4. Choose the directory in which to save the file.

5. Type a name in the File Name text field.

6. Select the file type from the File Type drop-down menu.

7. Click Save.

Accessing Reports From the Sun
Management Center Web Server
You can view a report as HTML in a browser. The report must first be saved and then
posted to a Sun Management Center web server. All scheduled reports are posted to
the Sun Management Center server machine. You can also post an individual report
by using the Post to a Web Server option from the report’s menu. A list of all reports
ever posted appears in the browser window that is opened from the server. All reports
continues to appear until the report is deleted.

� To Access a Posted Report

1. Start the Sun Management Center web server at the following URL:

http://server-machine-name:8080/prm/reports

Steps

Steps

68 Sun Management Center 3.6 Performance Reporting Manager User’s Guide • February 2005



2. Log in by typing your login name and password in the text fields.

Use the same login name and password that are required for the Sun Management
Center server.

A table is displayed in the browser window that lists all the reports that have been
posted to the web server. The name of the report request, the report category and
subcategory, the report title, and the create time are displayed in the table.

3. To view a report, click its name in the Report Title field.

The report is displayed in the browser window.

4. (Optional) To print the report, use the Print option in the browser.

5. Close the browser window.

� To Save an HTML Report as a Text File
You can save an HTML report viewed with the Mozilla browser as a text file. Other
web browsers have similar capabilities to save HTML files as text.

1. Start the Mozilla browser.

2. Display the desired report in the browser window.

For the detailed steps, see “To Access a Posted Report” on page 68.

3. Right click (mouse button 3) on the name of the report.

A pop-up menu is displayed.

4. Select Save Frame As from the This Frame option.

The Save As dialog box is displayed.

5. Select the directory to which you want to save the text file report.

6. Provide a name for the file.

7. Select Text File from the Files of type field.

8. Click Save.

The Save As dialog box is dismissed. The report data is saved as a text file.

� To Delete a Posted Report

1. Log in to the Sun Management Center web server.

For the detailed steps, see steps 1 and 2 in “To Access a Posted Report” on page 68.

Steps
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2. Click the selection box (to the left) of the report you want to delete.

See Example 5–1.

3. From the Report Actions pull-down list, choose Delete Selected.

You are asked to confirm the deletion.

4. Click OK.

The selected reports are deleted from the list in the table and is removed from the
web server.

Sample of a List of Reports That Are Posted to a Web Server

The figure below shows a sample of the list of posted reports as it appears in a
browser window.

Line Graph Report Viewing Options
If your report is in Line Graph format, you have several options for viewing the data.
Several buttons used to access the options are located at the top of the report window.
First, click the desired point on a graph, then click one of the following buttons:

Example 5–1
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� Disabled – Deactivates the mouse so a click on any line in the graph does not
register.

� Zoom – Enlarges, or zooms, the area selected on any line. Either click the desired
point or draw a lasso around a series of points for which you want more detail.
The area selected appears in enlarged detail.

� Alarms – A second window appears that contains a tabular report providing alarm
details for the date range specified in the report request.

� Processes – A second window appears that contains two tabular reports providing
detail about processes. One report is titled the Top 10 CPU Processes, and the other
is titled Top 10 Memory Processes. The report information is for the time
represented by the data point nearest to the point selected on the line. Process data
is logged every 15 minutes. Process data is available only for the last 8 days.

� Reset Zoom – Resets the graph orientation back to the initial starting point.

Customizing Line Graph Reports
Once you have run a report in line graph format, you can further customize the
appearance of the report. From the Edit menu, choose Customize Graph. The options
are the same as when completing a new custom report template. The difference is that
the customizing options you select after running a report apply only to that report.
You cannot save the changes, but you can post the customized report to a Sun
Management Center web server for viewing or printing.

For more information, see “Customizing the Appearance of Reports” on page 71.

Customizing the Appearance of Reports
Some custom report templates have an option that enables you to customize the
appearance of your Line Graph, Bar Chart, and Pie Chart reports. You add these
customizing features when you create the report request. You can also modify the
report request at a later time to include the desired appearance customization.

After you click the Customize button in the report template, the Customize Graph
dialog box appears. The dialog box contains the following three tabs, from which you
can specify these appearance changes:

� Titles & Legend – Enables you to add a footer and change the legend text. From the
drop-down menus, you can choose the placement of the footer or legend on the
graph. You can change the x-Axis and y-Axis labels using the text fields.

� Line Attributes – Use the All Lines options to change the appearance of the line
thickness or line style, and symbol size. Use the drop-down menus to make your
selections. Use the Specific Line options to change the appearance of a line you
select from the drop-down menu.
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� Size & Spacing – Use the text fields to control the size of the graph width and
height, or the x-Axis and y-Axis scale. You enable grid lines on the graph by
selecting Show Grid. The value range for grid spacing is 0 to 100.

Note – Some of the options in the Customize Graph dialog box are not available for Pie
Chart reports.

Once you have finished selecting all the customizing options, click OK to dismiss the
dialog box. You must also click OK from the report template for these options to be
saved to the report request.

Line Breaks
The legend of a report lists all the data properties contained in the report. You can
insert line breaks in the legend to enhance appearance. You use HTML commands to
do this. Inserting a line break by using an escape character such as \n does not work
as this character is not recognized.

� To Insert a Line Break

1. From the report window, choose Edit, then select Customize Graph.

The Customize Graph dialog box appears.

2. Select the Line Attributes folder.

The view changes to show the options already selected.

3. From the drop-down menu in the Selected Line field, select the name of the data
property you want to edit.

The name of the data property selected in the Selected Line field appears in the
Text field. You edit this field to insert the line break. The HTML tag <p> is used to
create the line break.

4. Insert the line break by typing:

<html>data_property_name<p></html>

The line break appears wherever the <p> tag is inserted. You can place this tag
anywhere in the full data property name. For example:

<html>% CPU <p>Kernel Time(0)</html>

results in the line break appearing after % CPU in the report legend.
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5. Click OK.

The line break appears in the report legend. Repeat this procedure for as many line
breaks as you want to insert.
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APPENDIX A

Reference Information

This appendix contains reference information for the Performance Reporting Manager
add-on software.

Default Logging Properties
The following properties are logged by default on the Sun Management Center agent
machines that have the Performance Reporting Manager software installed. You will
have either the kernelReader (simple) module or the kernelReader module
on your system. Both modules cannot be loaded at the same time.

The kernelReader (simple) module logs the following properties by default:

Load Average Over Last 5 Minutes
Physical Memory Free (MB)
Available KB (Anon Memory Not Reserved)
CPU User Time %
CPU Idle Time %
CPU Kernel Time %
CPU Wait Time On I/O %
Overall Percentage CPU Utilization
Overall Percentage CPU Idle

The kernelReader module logs the following properties by default:

Load Average Over Last 5 Minutes
Physical Memory Free (MB)
Available KB (Anon Memory Not Reserved)
CPU User Time %
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CPU Idle Time %
CPU Kernel Time %
CPU Wait Time On I/O %
Overall Percentage CPU Utilization
Overall Percentage CPU Idle

Predefined Options for Standard Reports
Each standard report included in Performance Reporting Manager contains predefined
report options that you cannot edit. The following table lists these predefined options.

TABLE A–1 Standard Report Options

Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

CPU
Utilization

Performance CPU % CPU Kernel Time
#ALL, % CPU User
Time #ALL

Provide at
runtime

Line
Graph

Overall CPU
Utilization

Performance CPU Overall Percentage
CPU Utilization,
Overall Percentage
CPU Idle

Provide at
runtime

Line
Graph

Swap
Available

Performance Swap Available KB (Anon
Memory Not
Reserved)

Provide at
runtime

Line
Graph

Memory
Free

Performance Memory Physical Memory
Free (Mbytes)

Provide at
runtime

Line
Graph

Alarm
Details

Alarm Alarms Hostname, OS,
Alarm Severity,
Alarm State, Open
Date, Alarm
Message

Provide at
runtime

Table

Alarm
Summary

Alarm Alarms Hostname, Alarm
State

All hosts in
the server
context

Table

Alarm
Severity
Count By
Host

Alarm Alarms Hostname, Alarm
Severity, Alarm
State

All hosts in
the server
context

Table
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TABLE A–1 Standard Report Options (Continued)
Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

System
Details

Hardware System Hostname,
Operating System,
System Clock
Frequency, Platform
Type, Total Disks,
Total Memory, Total
Processors, Total
Tape Devices

All hosts in
the server
context that
have the
Config-Reader
add-on
installed

Table

Platform
Summary

Hardware System Platform All hosts in
the server
context that
have the
Config-Reader
add-on
installed

Table

OS Summary Hardware System Operating System All hosts in
the server
context that
have the
Config-Reader
add-on
installed

Table

Hosts with
SUNWcsr
Package

Software Packages Hostname, Package
Instance, Package
Name, Category,
Version, Package
Description, Install
Date

All hosts in
the server
context

Table

Package
Details

Software Packages Hostname, Package
Instance, Package
Name, Category,
Version, Package
Description, Install
Date

Provide at
runtime

Table

Patch Details Software Patches Hostname,
Operating System,
PatchID, Packages,
Obsoletes, Requires,
Incompatibles

Provide at
runtime

Table

Uptime
Status

System
Uptime

Uptime Status Uptime Status Provide at
runtime

Bar
Graph
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TABLE A–1 Standard Report Options (Continued)
Report
Request Name Category Subcategory Data Properties Host and Port

Report
Format

Percentage
Uptime

System
Uptime

Percent
Uptime

Percentage Uptime Provide at
runtime

Line
Graph

Uptime
Hours

System
Uptime

Total Uptime Uptime Provide at
runtime

Line
Graph

For more information about standard reports, see “Standard Reports Overview”
on page 33.
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APPENDIX B

Installing Using the Command Line

This appendix contains procedures for installing, setting up, and removing the
Performance Reporting Manager software using the command line. Command-line
installation is an alternative to using the installation wizard.

For information about using the installation wizard, see Chapter 2.

This appendix discusses the following topics:

� “Installing the Performance Reporting Manager Software” on page 79
� “Setting Up Performance Reporting Manager” on page 81
� “Removing the Performance Reporting Manager Software” on page 82

Installing the Performance Reporting
Manager Software
Installation of Performance Reporting Manager using the command line follows the
standard Sun Management Center add-on software installation procedures. For more
information about installation of add-on software using the command line, see Sun
Management Center 3.6 Installation and Configuration Guide.

Performance Reporting Manager must be installed on the following layers of Sun
Management Center:

� Console layer
� Server layer
� Agent layer, on all hosts for which you want to generate reports

The interactive es-inst (enterprise system monitoring) installation script installs the
correct Performance Reporting Manager software packages on the console, server, and
agent layers. For all layers, the packages, module configuration files, and libraries are
installed in standard Sun Management Center locations.
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� To Install Performance Reporting Manager During
Sun Management Center Installation

� For information and detailed steps using the command line, see the Sun
Management Center 3.6 Installation and Configuration Guide.

� To Install Performance Reporting Manager
Individually

1. As superuser (su -), run the installation script by typing:

# /opt/SUNWsymon/sbin/es-inst

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

2. Provide the source directory of the Performance Reporting Manager files when
prompted.

Please enter the source directory:

� If installing from the software CD-ROM, type:

/cdrom/cdrom0/image

� If installing from a directory to which the software has been copied, type:

disk1/image

when disk1 is the name of the location where the software was copied.

3. To install the Performance Reporting Manager, answer “Yes” when prompted.

The es-inst script installs Performance Reporting Manager.

The es-inst script then automatically displays a setup prompt.

4. Determine whether you want to set up Performance Reporting Manager now or
at a later time.

� To set up the software at a later time, answer n for “No”. When you are ready
to run the setup process, see “To Set Up Performance Reporting Manager
Individually” on page 81.

� To set up the software now, answer y for “Yes”.

Step
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Setting Up Performance Reporting
Manager
After installation is complete, you must run the Performance Reporting Manager
setup script to configure the server and agent layers.

� To Set Up Performance Reporting Manager
Individually

Note – This procedure assumes that you chose not to set up Performance Reporting
Manager at the end of the installation process.

1. Run the Sun Management Center setup script as superuser (su -). Choose one
of the following options:

� To run setup on all components that are not yet set up, type:

# /opt/SUNWsymon/sbin/es-setup

� To run setup on the Performance Reporting Manager add-on software only,
type:

# /opt/SUNWsymon/sbin/es-setup -p PRM

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

2. When asked, choose the configuration size. Provide three data file locations.

During the server setup, you are given three different configuration choices based
on the number of agent machines and data properties you will monitor. You are
prompted three times for data file locations. While you can use the same directory
three times, try to use three different directories located on three different file
systems. This separation reduces disk I/O contention and results in better product
performance.

The space required depends upon the size of the configuration you choose during
setup. The data file locations require disk space as listed in the following table.

Steps
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Configuration Size First Directory Size Second Directory Size Third Directory Size

Small 2048 Mbytes 1536 Mbytes 1536 Mbytes

Medium 5120 Mbytes 4096 Mbytes 3072 Mbytes

Large 8192 Mbytes 7168 Mbytes 7168 Mbytes

Removing the Performance Reporting
Manager Software
The es-uninst removal script removes the Performance Reporting Manager add-on
software. This script removes the Performance Reporting Manager packages, and all
the data and configuration changes made during setup.

� To Remove Performance Reporting Manager Using
es-uninst

1. As superuser (su -), type:

# /opt/SUNWsymon/sbin/es-uninst

where /opt is the directory in which Sun Management Center is installed.
Substitute the name of the actual directory if it is different on your system.

The script displays the Sun Management Center products installed and prompts
you to uninstall each of them.

2. When the script prompts you to uninstall Performance Reporting Manager, type
y and press Enter.

You are prompted to change the setting.

3. Type n and press Enter.

You are prompted to preserve the data files.

4. Enter your answer and press Enter.

The Performance Reporting Manager packages and configuration files are
removed. If you chose not to preserve the data files, these files are removed as well.

Steps
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Glossary

custom report A report that you create by choosing the report specifications from the
options given in the report template. The choices are saved to a report
request, which is used to generate the report when needed.

data collection service A service on the server layer that collects data from the agent machines
and stores the data in the database on the server.

group logging The ability to log the same set of data properties on a group of agent
machines. Group logging is part of the Manage Jobs features of Sun
Management Center that Performance Reporting Manager uses.

history logging The ability to log data that is part of Sun Management Center. Logged
data is collected and stored in the history log files that are located on
the agent machine. This data is used in reports created with
Performance Reporting Manager.

hourly data Data that has been summarized, or rolled-up, every hour.

lock icon A lock symbol that is added to all standard report icons as a reminder
that the report specifications are predefined and cannot be changed.

logging component A component on agent machines that is added as part of the
Performance Reporting Manager installation to perform logging of
system data properties.

module instance An entry in the Property Chooser dialog box when adding data
properties to a custom performance report request. The module
instance is required only for multi-instance modules, for example, File
Monitoring or Directory Monitoring.

performance report A report that is designed to track properties that are numerical and
that change over time.

property instance An instance name given to the data property that is being logged. A
property instance can be a required entry in the Select Data Properties
dialog box when adding data properties to a custom performance
report request.
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raw data Data that is logged in the history log files located on the agent
machines. Raw data is retained on the agent machine for eight days.
The data is summarized, or rolled-up, before it is purged.

Report Manager The graphical user interface in Performance Reporting Manager from
which you manage all report activity. Report Manager is linked to the
Sun Management Center Java console only.

report request Contains the saved report specifications that define the scope and
nature of the report. A report request is used to generate any report.

report template A form included with Performance Reporting Manager that guides
you through choices when creating your own custom report request.
Several report templates are provided, each specific to the type of
report request being created. The correct template is automatically
displayed depending upon the report type selected from the File
menu.

roll-up data Data that has been summarized. All data is summarized, or rolled-up,
before it is purged.

server context A Sun Management Center sever layer and its associated agents.

standard report A report whose report request is included with the product, and whose
report specifications are predefined. The report specifications in a
standard report request cannot be changed.

system configuration
report

A report that provides data that details the state of the configuration
on a machine.

topology view The view that displays the members of the object selected in the
hierarchy view.
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Index

A
accessing posted reports, 68
adding

category or subcategory, 42
data properties, 55-56

agent update, 30
Alarm Details report, 36
alarm reports

description of, 35
host name, 12

Alarm Severity Count By Host report, 36
Alarm Summary report, 36
Alarms button, 17, 71
area chart report, 19
average data, 46

B
backing up data, 29
bar chart reports

customizing, 71
description of, 18
stacked bar area, 19

browser, viewing reports in, 67

C
category

adding new, 42
list of predefined, 16
selecting, 44

column sizing, 17
comma- or tab-separated text report, 20
composite report request, 63
CPU Utilization report, 34
creating

category, 42
custom report, 49
report request, 43
subcategory, 42

custom reports
description of, 41
determining data type for, 46
filtering, 63
templates for, 43
time range for, 47

Customize, report field, 46
customizing

line graph reports, 71
report appearance, 71

D
data

availability, 14
exporting, 68
hardware configuration, 14
hardware system, 14
hourly report of, 13
patch and package, 14
performance, 34
polling, 14
retention, 14
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data (Continued)
rolled-up, 13
stopping collection of, 62
summary, 14
transfer of, 34
types of collection, 12

Data Availability dialog box, 52
data collection, 14

enable or disable, 61
service, 12, 14
stopping, 62
types of, 12

data files
server layer, 28, 81

data logging
history.log file, 51
intervals, 14
overview, 13
performance, 34

data properties
adding, 54
adding for group task, 57
available, 52
logging, 56
report field, 45, 54

data types, 12
database, 35
date format, 66
Disabled button, 71
disabling data logging, 56
disk space requirements, 22

E
enabling data logging, 56
environment, setting, 28
exporting data, 68

F
fields, See report field
Filter dialog box, 63
filtering reports, 63
footers, adding to graph, 71
Function field, 46

G
Generate icon, 38
generating a report, 38
graph

displaying grid in, 71
orientation, 47
viewing options, 70

grid, displaying in graph, 71
group logging, 57
grouping functionality, logging interval, 13

H
Hardware Configuration Report, 43
hierarchy view, 37
history.log file, 51
host name

alarm reports, 12
selecting options for report, 45
standard performance report, 39

Hosts with SUNWcsr package report, 36
hourly data, 13
HTML

saving as text report, 69
viewing a report as, 67

I
installation

layers, 24, 79
requirements, 22

installing Performance Reporting Manager
command-line instructions for, 79
individually, 27-29
individually on Microsoft Windows, 26
on Microsoft Windows during Sun

Management Center 3.5
installation, 25-26

K
Kernel Reader Simple module, 34, 75
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L
legend, modifying, 71
level of detail, report field, 48
Line Attributes tab, 71
line break, inserting in a report, 72-73
line graph reports

customizing, 71
description of, 17
viewing options, 17, 70

lock symbol, 17, 33
logging component, 35
logging data properties

default, 75
enabling or disabling, 56
group, 57

M
maximum data, 46
Memory Free report, 35
Microsoft Windows, installing Performance

Reporting Manager on, 25-26
minimum data, 47
modifying

legend, 71
report request, 49

module instance, 54
multi-instance modules, 54

N
No Data Found error, 52

O
OS Summary report, 36
output format options for reports, 16
output mode, 45

P
Package Details reports, 36
packages, add-on, 22
Patch Details reports, 36

Performance Reporting Manager
back up and restore, 29
installing individually, 80
installing individually on Microsoft

Windows, 26
installing through the command line, 79
prerequisites for, 21
setting up, 26, 81
software packages, 22
standard reports, 33
uninstalling, 31
upgrading, 30

performance reports
definition, 33
report fields, 46
template, 43

pie chart reports
customizing, 71
description of, 19

Platform Summary report, 36
port, default, 45
posted reports, 68
predefined options for standard reports, list

of, 76
preview, 50, 64
printing reports, 39-40
Processes button, 17, 71
property instance, 54
Property Logging Setting dialog box, 56

R
raw data, 13, 46
raw function, 46
real time, 47

graph refresh interval, 17
Refesh button, 17
removing

Performance Reporting Manager software
through the command-line, 82

Performance Reporting Manager software
through the GUI, 31

posted reports, 69-70
scheduled reports, 66-67

report, standard icon, 17
report data

availability, 14, 51
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report data (Continued)
retaining, 14

report field
Category, 44
common to all templates, 44
Customize, 46
Data Properties, 45
Filter, 48
Function, 46
Graph Orientation, 47
Level of Detail, 48
Output Mode, 45
performance report template only, 46
Report Request, 44
Report Title, 44
Selected Hosts, 45
Subcategory, 44
system configuration report template

only, 48
Time Range, 47

report formats
area chart, 19
bar chart, 18
comma- or tab-separated text, 20
line graph, 17
pie chart, 19
stacked area chart, 19
stacked bar area chart, 19
table, 17

Report Manager GUI
description of, 37
starting, 37-38

Report Request report field, 44
report requests

alarms, 43
composite, 63
definition of, 43
description of, 15
hardware configuration, 43
hierarchy view, 37
modifying, 49
package, 43
patch, 43
performance, 43
system, 43

reports
See also report data, report field, report

formats, and report requests

reports (Continued)
custom, 41
customizing the appearance of, 71
filtering, 63
generating, 38
icons, 17
output format options for, 16
performance, 33, 43
posted as HTML, 68
printing, 39-40
scheduling, 66
standard, 33
standard system configuration, 33
system configuration, 43
templates, 41, 43
types, 11
viewing in different formats, 67

Reset Zoom button, 71
restoring data, 29
roll-up data process, 13

S
samples

Data Availability dialog box, 53
Data Collection dialog box, 61
line graph report, 17
New Performance Report Request

template, 50
posted reports in a browser, 70
Property Logging Setting dialog box, 58
Report Manager, 37
Select Data Properties dialog box, 55

scheduling a report, 66
script

es-inst, 79
setup, 26, 81

select data properties dialog box, 45
selected hosts, choices, 45
server layer

data files, 28, 81
setting the environment, 28

setting up Performance Reporting Manager
command-line instructions for, 81
individually, 27-29
overview, 26
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setup
script, 26, 81
server data files, 28, 81

Show Grid option, 72
Size & Spacing tab, 72
sorting tabular reports, 17
stacked area chart report, 19
stacked bar area chart report, 19
standard performance reports

CPU Utilization, 34
host name, 39
list of types, 34
Memory Free, 35
Swap Available, 35

standard reports
Alarm Details, 36
Alarm Severity Count By Host, 36
Alarm Summary, 36
Hosts with SUNWcsr package, 36
Kernel Reader Simple module, 34
list of, 34, 35
OS Summary, 36
overview of, 33
Package Details, 36
Patch Details, 36
performance, 33
Platform Summary, 36
predefined options for, 76
system configuration, 33
System Details, 36

standard system configuration reports, host
name, 39

subcategory
adding new, 42
list of predefined, 16
selecting, 44

Swap Available report, 35
system configuration reports

level of detail in, 48
list of types, 35
template, 43

System Details report, 36

T
tabular reports, 17
text file reports, 20

Titles & Legend tab, 71
Top 10 CPU Processes report, 71
Top 10 Memory Processes report, 71

U
uninstalling Performance Reporting

Manager, 31
upgrading, 30

V
viewing

details for points in line graph report, 17, 70
report output, 67

X
X server, 28

Z
Zoom button, 17, 71
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